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ABSTRACT 

The use of the Telegram chat application as an interface to control IoT devices, such as lights, is an 

interesting application. The main objective of this research is to integrate Telegram into an electronic 

device control system and create an interface that allows users to turn lights on and off using Telegram 

instant messages. The method used in this research is Research and Development (R&D). This prototype 

requires components such as Telegram, NodeMCU Esp8266, relay module, jumper wires, and the 

Internet of Things. Based on the achievements of the design and prototype testing, it can be concluded 

that by integrating Telegram as a platform, users can control lights remotely using the Telegram instant 

messaging application as a controller. 
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ABSTRAK 

   

Penggunaan aplikasi chatting Telegram sebagai antarmuka untuk mengendalikan perangkat Internet of 

Things, seperti lampu, menjadi salah satu penerapan yang menarik. Tujuan utama dari penelitian ini 

adalah untuk mengintegrasikan Telegram ke dalam sistem kendali perangkat elektronik dan membuat 

antarmuka yang memungkinkan pengguna menyalakan dan mematikan lampu menggunakan pesan 

instan telegram. Metode yang digunakan dalam penelitian ini adalah R&D. Prototype ini membutuhkan 

komponen seperti Telegram, NodeMCU Esp8266, modul relay, kabel jumper, Intenet of Things. 

Berdasarkan pencapaian perancangan dan percobaan prototype mengendalikan lampu darai jarak jauh 

dapat diambil kesimpulan bahwa, dengan mengintegrasikan Telegram sebagai platform, pengguna dapat 

mengontrol lampu dari jarak jauh menggunakan aplikasi pesan instan Telegram sebagai pengendali. 

 

Kata Kunci:  Aplikasi pesan, Intenet of Things, lampu otomatis 
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I.    PENDAHULUAN 

Internet of Things telah merambah ke 

berbagai aspek kehidupan sehari-hari, 

mengubah cara kita berinteraksi dengan 

perangkat elektronik dan lingkungan sekitar. 

Salah satu aplikasi praktis dari konsep Internet 

of Things adalah pengendalian perangkat 

elektronik secara jarak jauh melalui koneksi 

internet. Dalam hal ini, penggunaan aplikasi 

chatting Telegram sebagai antarmuka untuk 

mengendalikan perangkat Internet of Things, 

seperti lampu, menjadi salah satu penerapan 

yang menarik. Aplikasi chatting Telegram 

adalah salah satu aplikasi yang paling umum 

digunakan dalam komunikasi sehari-hari, dan 

mengintegrasikannya dengan kontrol Internet 

of Things memberikan kenyamanan dan 

fleksibilitas tambahan bagi pengguna [2]. 

Namun, meskipun konsep ini 

menjanjikan banyak manfaat, ada beberapa 

tantangan yang perlu diatasi dalam 

penerapannya. Salah satunya adalah keamanan. 

Menghubungkan perangkat rumah tangga 

seperti lampu ke internet meningkatkan risiko 

keamanan terhadap serangan siber. Selain itu, 

integrasi yang tidak efisien antara aplikasi 

chatting dan perangkat Internet of Things dapat 

mengakibatkan keterbatasan fungsionalitas atau 

kinerja yang kurang optimal. 

Ketergantungan pada koneksi internet: 

Aplikasi chatting yang menggunakan Internet 

of Things untuk mengendalikan lampu 

membutuhkan koneksi internet yang stabil [5].  

Ketergantungan ini dapat menjadi masalah jika 

terjadi gangguan jaringan atau sinyal yang 

buruk, yang dapat menyebabkan 

ketidakmampuan pengguna untuk mengontrol 

lampu. Data yang dikumpulkan dari 

penggunaan aplikasi chatting yang terhubung 

dengan Internet of Things harus dikelola dengan 

baik untuk melindungi privasi pengguna. Ini 

termasuk kebutuhan akan kebijakan privasi 

yang jelas dan perlindungan data yang tepat. 

 

II.   TINJAUAN PUSTAKA 

Internet of Things 

Internet of Things (IoT) adalah jaringan 

yang menghubungkan berbagai objek dengan 

identitas dan alamat IP yang dapat diidentifikasi 

sehingga mereka dapat berkomunikasi satu 

sama lain dan bertukar informasi tentang diri 

mereka sendiri dan lingkungan yang mereka 

rasakan. Objek IoT dapat menggunakan atau 

menghasilkan layanan dan berkolaborasi untuk 

mencapai tujuan bersama. Dengan 

menggunakan sensor pintar, data analog diubah 

menjadi digital dan kemudian dikirim ke 

prosesor secara real time. Dengan cara ini, 

otomatisasi perangkat yang dikendalikan dari 

jarak jauh dapat diwujudkan dalam arsitektur 

IoT [1]. 

 

Gambar 1. Arsitektur IoT 

Relay 

Relay adalah perangkat elektronik yang 

dapat mengalihkan kontak switching ketika 

menerima sinyal listrik. Relai atau control relay 

(CR) merupakan saklar magnet yang berfungsi 

secara otomatis seperti kontaktor magnet. 

Dibandingkan dengan kontaktor [4]. Relay 

dirancang untuk tugas yang lebih sederhana.  

Kontaknya harus lebih kecil dan terbuat dari 

bahan konduktif berkualitas baik. Logam perak 

umumnya digunakan sebagai bahan kontak 

relay, namun logam mulia lainnya juga dapat 

digunakan. 

 

Gambar 2. Modul Relay 

 
Ketika kumparan diberi energi, maka 

timbullah medan magnet yang menyebabkan 

pegas kontak bergerak atau tertarik dan 

menempel pada kumparan. Ujung pegas kontak 

berpindah dari satu posisi ke posisi lain atau 

kontak sebelumnya. Perbedaan utama antara 

relay dan sakelar terletak pada proses 

pemindahan dari posisi ON ke OFF. Relay 

melakukan pemindahan ini secara otomatis 

melalui arus listrik, sementara sakelar 

melakukan pemindahan tersebut secara manual. 
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Modul NodeMCU ESP8266  

Modul NodeMCU ESP8266 

NodeMCU adalah sebuah papan Elektronik 

berdasarkan chip ESP8266 dengan kemampuan 

menjalankan fungsinya Mikrokontroler dan 

koneksi Internet (akses internet nirkabel) [3].  

ESP-8266 memiliki kemampuan on-board 

prosessing dan storage yang memungkinkan 

untuk diintegrasikan dengan sensor-sensor atau 

dengan aplikasi tertentu melalui pin input 

oputput hanya dengan pemrograman. Selain itu, 

ESP-8266 dilengkapi dengan fitur deep sleep 

mode sehingga penggunaan daya akan jauh 

relative lebih efisien. 

Gambar 3. Modul NodeMCU 

 

Telegram 

Telegram adalah aplikasi pesan instan 

berbasis cloud yang berfokus pada kecepatan 

dan keamanan. Telegram dirancang untuk 

memungkinkan pengguna saling mengirim 

pesan teks, audio, video, gambar, dan stiker 

dengan mudah dan aman [8]. 

Keunggulan Telegram adalah berbasis 

cloud dan memungkinkan Anda mengakses 

pesan dari beberapa perangkat. Selain itu, 

Telegram juga tergolong cepat dalam 

menyampaikan pesan dibandingkan aplikasi 

lainnya. Oleh karena itu, pemahaman 

mendalam tentang media dan teknologi serta 

pemanfaatannya merupakan kebutuhan 

mendesak untuk mengatasi lajunya perubahan 

generasi ke generasi berikut gaya dan karakter 

mereka dalam menggunakan teknologi [14]. 

 

III. METODOLOGI 

Dalam penelitian ini, peneliti 

menerapkan metode penelitian dan 

pengembangan (R&D), dalam hal ini untuk 

memudahkan pembuatan, mengurangi 

pengeluaran, dan menghimpun data yang lebih 

relevan dalam rangka penelitian pembuatan alat 

prototype. Adapun langkah metode yang di 

gunakan sebagai berikut: Potensi dan masalah, 

pengumpulan data, desain produk, validasi 

desain, revisi desain, ujicoba produk. 

 

Diagram Blok 

     Berikut merupakan diagram blok 

dari sistem prototipe peneraapan aplikasi 

chating telegram pada HP untuk menyalakan 

Lampu dari jarak jauh. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4. Diagram blok 

 

Flowchart Prinsip Kerja Alat 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 5. Flowchart Prinsip Kerja Alat 

 

Cara kerja system, sebagai berikut: 

User terhubung dengan internet 

menggunkan Smartphone Android untuk 

memeberikan perintah menyalakan lampu atau 

mematikan lampu melalui telegram chatbot. 

NodeMCU ESP8266 harus terhubung dengan 

internet agar seluruh sistem dapat 

berkomunikasi dengan baik. NodeMCU 

ESP8266 berfungsi sebagai penghubung ke 

internet yang akan mengrim dan menerima 

intruksi dari User. NodeMCU bertugas 
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mengeksekusi intruksi yang masuk dari chatbot 

lalu mengirimkan perintah ke Relay agar 

kondisi lampu dapat menyala atau mati. 

Ketika lampu sudah sesuai perintah, maka 

lampu akan memeberikan respon feedback ke 

chatbot melalui server Telegram, apakah 

kondisi lampu menyala atau mati. Respon dari 

lampu tersebut akan di baca oleh NodeMCU 

yang dihubungkan dengan Relay, kemudian 

intruksi akan dikirimkan ke server dan user 

akan mendapat notifikasi dari Telegram 

chatbot. 

Hasil dari perintah respon lampu dari 

NodeMCU yang terkoneksi dengan internet dan 

diakses oleh server Telegram, kemudian user 

akan menerima repon berupa status dari 

keadaan lampu [6]. NodeMCU memgirimkan 

feedback hasil intruksi ke Telegram chatbot dan 

ESP8266 yang berfungsi menghubungkan 

internet, agar pesan yang dikirimkan dapat 

diterima oleh User. User menerima hasil respon 

dari Relay yang di operasikan melalui 

NodeMCU yang terhubung dengan internet, 

hasil dari intruksi perintah tersebut kemudian 

dikirimkan ke user bahwa lampu dapat 

dihidupkan. 

 

IV. HASIL DAN PEMBAHASAN 

 

Pembuatan prototype 

Prototype Alat yang telah diilustrasikan 

seperti diatas direncanakan agar memiliki 

kemampuan untuk mengontrol lampu dari jarak 

jauh [7]. Tujuan dari setiap elemen yang 

digunakan  yaitu, Telegram bertugas 

mengirimkan signal perintah ke NodeMCU 

Esp8266, NodeMCU Esp8266 bertugas 

mengeksekusi intruksi yang masuk dari 

telegram lalu mengirimkan perintah ke relay, 

Relay bertugas sebagai penerima perintah agar 

kondisi lampu dapat menyala atau mati sesui 

dengan perintah yang diberikan.  

 

Gambar 6. Prototype produk 

 

 

 

 

Gambar 7. Aplikasi chatting 

 

Pembuatan Perangkat lunak 

Berikut adalah langkah-langkah desain dan 

proses upload kode ke perangkat keras untuk 

mengendalikan lampu dari jarak jauh 

menggunakan Arduinu IDE: 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 8. Diagram Blok Instalasi 

Perangkat Lunak 

 

Pengujian Prototipe 

 

1. Pengujian NodeMCU ESP8266 

Pengujian dilakukan dengan cara 

memberikan tegangan input kepada NodeMCU 

ESP8266 menggunakan adaptor 12 volt atau 9 

volt. Jika lampu indikator pada NodeMCU 

ESP8266 sudah menyala, maka bisa dipastikan 

NodeMCU ESP8266 sudah terhubung dengan 

tegangan. Untuk menghubungkan perangkat 

mikrocontroller seperti ESP 6266 ke jaringan 

WiFi, Berikut adalah langkah-langkah untuk 

menghubungkan ESP8266 ke WiFi. 
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Hubungkan ESP8266 ke Relay: Ikuti 

instruksi manual papan pengembangan Anda 

untuk menghubungkan modul ESP8266 dengan 

benar. Pastikan pin VCC, GND, D1,D2,D3 dan 

D4 terhubung dengan benar. Instal pustaka 

ESP8266: Buka Arduino IDE dan File > 

preferencs. Dibawah Addtional Board Manager 

URLs, tambahkan URL 

berikut:http//arduino.esp8266.com/package 

esp8266com.zip. Klik OK. Tambahkan Pustaka 

ESP8266: Buka Tools > Manage Libraries. 

Cari "ESP8266" dan instal pustaka 

"ESP8266WiFi". 

Selanjutnya Buka contoh kode "WiFi" 

yang terdapat di File > Examples > 

ESP8266WiFi > WiFiScan. Ubah SSID dan 

Kata Sandi: Dalam contoh kode, ubah nilai 

variabel ssid dengan nama jaringan WiFi Anda 

dan ubah nilai variabel password dengan kata 

sandi jaringan WiFi Anda. Unggah Kode: 

Hubungkan papan pengembangan ke komputer 

Anda melalui kabel USB. Pilih papan ESP8266 

Anda di menu Tools > Board. Klik tombol 

Upload untuk mengunggah kode ke ESP8266. 

Setelah kode diunggah, buka monitor serial di 

Arduino IDE dengan menekan Tools > Serial 

Monitor. Atur baud rate ke 115200. Jika 

ESP8266 berhasil terhubung ke WiFi, Anda 

akan melihat pesan "WiFi connected" di 

monitor serial. 

 

2. Pengujian Modul Relay 

Modul relay berfungsi sebagai saklar 

elektromagnetik yang dapat mengontrol aliran 

listrik pada rangkaian. Pengujian dilakuakan 

dengan cara memberikan tegangan kepada 

Modul Relay dengan menghubungkan pin VV, 

pin G dan pin D1 pada NodeMCU ESP8266 

dengan pin vcc, GND dan D1 yang ada pada 

modul Relay, jika lampu indikator pada modul 

relay menyala, maka bisa dipastikan relay sudah 

terhubung dengan tegangan. 

 

3. Pengujian aplikasi chatting Telegram 

Aplikasi Cahtting Telegram berfungsi 

sebagai pengedaali dan memberikan perintah 

kepada NodeMCU ESP8266 agar lampu 

menyala dan mati sesuai dengan perintah 

pengguna [11]. Pengujian dilakukan dengan 

cara menghubungkan internet agar dapat 

mengaktifkan aplikasi telagram dan membuka 

fitur yang ada didalam aplikasi telegram, apa 

bila mampu membuka dengan baik bisa 

dipastikan aplikasi Telegram berfungsi. 

 

V.  PENUTUP 

Pengendalikan lampu dari jarak jauh  

adalah  solusi  yang  inovatif  dan dapat 

memberikan berbagai manfaat. Hasil produk 

yang dibuat dapat berfungsi sesuai dengan 

perencanaan yang telah dibuat, sehingga 

dengan mengintegrasikan Telegram sebagai 

platform pengendalian, pengguna dapat 

mengontrol lampu dari jarak jauh menggunakan 

aplikasi pesan instan. Disarankan agar 

penelitian selanjutnya dapat menguji alat 

tersebut dari jarak jauh, seperti dari luar kota 

atau bahkan luar negeri. Selain itu, 

pengembangan juga dapat dilakukan pada 

aplikasi media sosial lain yang banyak 

digunakan oleh masyarakat. 

 

 

DAFTAR PUSTAKA 

1] Wilianto, W., & Kurniawan, A. (2018). 

Sejarah, cara kerja dan manfaat internet 

of things. Matrix: Jurnal Manajemen 

Teknologi Dan Informatika, 8(2), 36-

41. 

[2] Huda, A., & Ardi, N. (2021). Teknik 

Multimedia dan Animasi.. 

[3] Nega, M., Susanti, E., & Hamzah, A. 

(2019). Internet Of Things (Iot) Kontrol 

Lampu RumahMenggunakan Nodemcu 

Dan Esp-12e BerbasisTelegram 

Chatbot. Jurnal SCRIPT, 7(1), 88-99. 

[4] Lase, F. (2021). Rancang Bangun Alat 

Pengontrolan Irigasi Berbasis Internet 

of Things (Doctoral dissertation, Prodi 

Teknik Informatika).. 

[5] Yazid, Y. A. M., & Permana, R. A. 

(2023). Prototipe Monitoring Lampu 
Jalan Otomatis Menggunakan 

Mikrokontroller ESP32 dan Api 

BOTTelegram. Jurnal Teknik 

Informatika, 9(2), 57-62. 

[6] Raditya, W., Styawati, S., Surahman, 

A., Budiawan, A., Amanda, F., Putri, N. 

D., & Yudha, S. (2022). Penerapan 

Sistem Keamanan Gerbang Rumah 

Berbasis Telegram Menggunakan 

Esp8266. Jurnal Teknik dan Sistem 

Komputer, 3(2), 93-103. 

[7] Prasetya, M. A., & Aulia, R. (2020). 

Prototype Penerangan Lampu Taman 

Otomatis Menggunakan Arduino 

Uno. CESS (Journal Comput. Eng. 

Syst. Sci., vol. 5, no. 1, p. 109, 2020, 

doi: 10.24114/cess. v5i1. 15889. 



e-ISSN: 2685-9556 p-ISSN: 2686-0139 Volume 7 Issue 1 

14 

Aisyah Journal of Informatics and Electrical Engineering 

 

[8] Efendi, M. Y. (2019). Implementasi 

Internet of Things Pada Sistem Kendali 

Lampu Rumah Menggunakan Telegram 

Messenger Bot Dan Nodemcu Esp 

8266 (Doctoral dissertation, Prodi 

Teknik Informatika). 

[9] Asmaleni, P., Hamdani, D., & Sakti, I. 

(2020). Pengembangan Sistem Kontrol 

Kipas Angin Dan Lampu Otomatis 

Berbasis Saklar Suara 

 

[10] Destiarini, P. W. K., & Kumara, P. W. 

(2019). Robot line follower berbasis 

mikrokontroller arduino uno 

Atmega328. Jurnal Informanika, 5(1), 

19-25. 

[11] Ibrahim, A. M., & Setiyadi, D. (2021). 

Prototype Pengendalian Lampu Dan Ac 

Jarak Jauh Dengan Jaringan Internet 

Menggunakan Aplikasi Telegram 

Berbasis Nodemcu Esp8266. Infotech: 

Journal of Technology 

Information, 7(1), 27-34. 

[12] Ramadhan, M. W. (2021). Controlling 

Lampu Rumah Berbasis Iot. Exact 

Papers In Compilation (Epic), 3(2), 

353-360.. 

[13] WHPHISHER: Phising. Jurnal Teknik 

Mesin, Elektro dan Ilmu 

Komputer, 3(1), 23-31. 

[14] Yaumi, M., & Damopolii, M. (2015). 

Trasnformasi Organisasi, Pengelolaan 

Sumber Daya, Dan Aplikasi Sistem 

Informasi Pada Pascasarjana UIN 

Alauddin Makassar. Lentera 

Pendidikan: Jurnal Ilmu Tarbiyah dan 

Keguruan , 18 (1), 27-41. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


